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1.1. APMS Overview 
The Aviation Performance Measuring System (APMS) is a method-embodied in software-that 

uses mathematical algorithms and related procedures to analyze digital flight data extracted fiom 
aircraft flight data recorders. 

APMS consists of an integrated set of tools used to perform two primary functions: 

0 Flight Data Importation 

0 Flight Data Analysis 
These functions are described below. 

1 .I -1. Flight Data Importation 
Air carriers store digital flight data on a variety of media including optical disks and electronic 

memory devices. These data are regularly downloaded and processed with the use of commercial 
flight data processing software. This commercial software converts the data fiom their native storage 
units into standard engineering units. It also identifies exceedance events in the data and generates 
standard reports and statistics characterizing the data. The results of this processing activity are stored 
in online data stores of varying formats. All of this activity by commercial flight data processing 
software occurs prior to data importation by APMS. 

by the commercial flight data processing software. These tools locate new flight data and perform 
various filtering, structuring, signature extraction, compression, and storage processes. 

Editor. 

On a regular basis, APMS data importation tools are used to access the online data stores created 

APMS data importation tools include the Loader, Parameter Editor, Phase Editor, and Fleet 

1 .I .2. Flight Data Analysis 
APMS includes tools that permit flight analysis to be performed by both computers and humans, 

since both are necessary to produce meaningful results. The following paragraphs describe how this is 
accomplished. 

Go m pu terized Analysis 
The computerized analysis process is performed by the Analysis Engine. This tool examines the 

imported data to determine typical flight patterns and also identifies flights that do not conform well 
to any typical pattern. The Analysis Engine does this by using statistical, rather than operational, 
criteria. It ranks atypical flights in order of their degree of deviation fiom the norm. The system finds 
the specific flight phases that are atypical and identifies the flight parameters that contributed to the 
unusual performance. Since the Analysis Engine accomplishes these various functions without any 

Introduction Page 1 of 104 
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prior human specification of normal or operationally interesting flights, it can reveal unexpected 
events or trends that could compromise the safety of flight operations. 

H u man-G u ided Analysis 
Atypical flights identified by the Analysis Engine are brought to the attention of airline safety 

analysts, who use other APMS tools to determine whether these flights are of operational interest. The 
Morning Report tool is a key component in the human-guided analysis of flight data. "his tool 
displays the output of the Analysis Engine. Because words can often convey more meaning than raw 
statistics to air carrier analysts, the Morning Report provides textual descriptions of the atypical flights 
identified by the Analysis Engine. The Morning Report also displays graphical representations of the 
Analysis Engine's findings in the form ofparameter traces and parameter clouds. The latter depict 
the range of variation commonly observed in the flight data. This graphical visualization provides a 
fiame of reference against which parameter traces fiom atypical flights can be displayed and visually 
assessed by human analysts. 

In addition to Morning Report, human-guided analysis tools include Viewer, Data Exploration, 
Search Pattern, Events Charts, and Reports. Aviation safety analysts use the Flight Validation tool to 
record their findings. I 

1.2. Document Scope 

This document is written for aviation safety analysts who use APMS to analyze digital flight data. 
It contains descriptions of the human-guided flight analysis tools available in APMS 3.0. Each of 
these tools except the Viewer is directly accessible from the APMS Main Toolbar (see Figure 1.1). 
The Viewer is accessible fiom within most of the other tools. 

The following flight analysis tools are described in detail: 
0 MorningReport 
0 Data Exploration 
0 Viewer 

0 Search Pattern 
0 Eventcharts 
0 Flight Validation 

0 Reports 

Introduction Page 2 of 104 
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1.2. Utilities Toolbar 

The Utilities Toolbar (see Figure 1.2) provides access to several tools that are used primarily by 
systems administrators to configure APMS for data importation and to set up user permissions. The 
Utilities Toolbar also provides access to the Analysis Engine that is used to perform computer-driven 
flight analysis. For a description of the tools in the Utilities Toolbar, see the APMS 3.0 System 
Administrator’s Guide. 

I .3. Document Styles 
e Bold text is used throughout this document to identify user interface features such as windows, 

buttons, and fields. 
0 Italicized text is used throughout this document to identify APMS-specific terms defined in the 

Glossary (see Section 0). t 
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#i 

2.1 . Start Application 
Figure 2.1. APMS Shortcut Icon 

Before using any of the APMS flight analysis tools, flight analysts must start the application and 
log in. To begin, click the APMS Shortcut icon (see Figure 2.1) on the computer desktop. 

2.2. Log In 

To log in, perform the following steps: 

0 Select the appropriate user name in the User drop-down list. 

0 Enter the password in the Password text box. 

0 ClickLogin. 

Getting Started 

Start Application Revision: 0.5.1 * 
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2.3. Select Tool 
Fiaure 2.3. APMS Main Toolbar 

In the APMS Main Toolbar (see Figure 2.3), click the icon of any available flight analysis tool. 

Page 6 of 104 Getting Started 
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II 

3.1. Overview 
The Morning Report tool provides textual descriptions and graphical representations of data 

imported from analysis reports, which are generated by an APMS utility called the Analysis Engine. 
To understand the Morning Report tool, it is important to learn more about these analysis reports. 

with data from earlier, or baseline, flights. However, only the new flights are listed in the analysis 
report. New and existing flights from the same fleet (and, if applicable, from the same originating or 
destination airport) are grouped by phase to form a 1,000-flight aggregation. The computerized 
analysis determines typical flight patterns for the aggregation and also identifies phases in the new 
flights that do not conform well to any typical pattern. The Analysis Engine then ranks the atypical 
flights and phases in order of their degree of deviation from the norm. The system also identifies the 
flight parameters that contributed to the unusual performance. 

The Morning Report tool allows analysts to view and investigate these atypicalities-flights or 
phases of flights containing parameter values that deviate from the group norm. Each atypical flight or 
flight phase is ranked from 1 (lowest degree of deviation) to 3 (highest). When a rank applies to a 
single flight phase (such as Takeoff or Landing), it is called a phase atypicality rank. When a rank 
applies to an entire flight (all combined phases), it is called a global atypicality rank. 

It’s important to note that Level 3 atypicalities in the Morning Report do not necessarily point to 
safety or quality problems in the flights or phases in which they appear. Instead, atypicalities should 
be considered as starting points for further investigation of potential problems. Analysts must gather 
additional flight information (with the help of other tools in the APMS suite) to validate or invalidate 
atypicalities in the Morning Report. For example, an analyst might invalidate or exempt atypicalities 
resulting from bad data sensors or weather-related flight adjustments. 

The Analysis Engine produces analysis reports by comparing data from newly imported flights 

3.2. Details 
3.2.1. Select Analysis Report 

Figure 3.1. Start Morning Report Window 

The Start Morning Report window (see Figure 3.1) provides access to the list of analysis reports. 

Morning Report 
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To view the list of available reports, select Morning ReporOChoose Morning Report in the 
menu. 

The Morning Report Selector window (see Figure 3.2) contains a list of the available analysis 
reports. Note that the list includes the date that each report was generated by the Analysis Engine tool. 

To view a specific report, select it and click View Morning Report. 

Morning Report 

Details Revision: 0.5.1 a 
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3.2.2. View Analysis Summary 

The Morning Report Summary window (see Figure 3.3) summarizes the global and phase 
atypicalities contained in the report. In this example, note that there are three Level 3 global 
atypicalities and four Level 3 phase atypicalities. Also note that Morning Report atypicality levels can 
be identified by the following colors: 

0 Red-Level 3 (most atypical) 
0 Yellow-Level 2 
0 Aqua-Level 1 (least atypical) 

To view more details about the atypical flights and flight phases in the report, click Go to Flight 
List. 

Morning Report 
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3.2.3. View Flight List 

The Morning Report Flight List window (see Figure 3.4) lists the flights and phases with 
atypicalities. The Flight column contains a flight’s unique FFD (Full Flight Data) or SFFD 
(Scrubbed Full Flight Data) nu s is the number that the APMS system uses to track different 
flights. This window also lists the processing date, phase, airport origin, airport destination, validation 
status, and significant parameters of every flight. Note that a flight’s global atypicality rank appears in 

d the phase atypicality rank appears in the 
an one phase atypicality are preceded with a er 

atypical phases in the flight, simply click in any column of the line. 
r traces of an atypical phase, select the appropriate line and then click 

s are computed by phase with other flights in an aggregation, a group of 
new and existing flights (typically totaling 1,000) used by the Analysis Engine to produce an 
analysis report. Low-elevation flight phases (Taxi-out, Takeoff, Low Speed Climb, Low Speed 
Descent, Final Approach, Landing, and Taxi-in) are aggregated by phase, fleet, and airport. 
High-elevation flight phases (High Speed Climb, Cruise, and High Speed Descent) are 
aggregated by phase and fleet only. 

Morning Report 
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3.2.4. View Parameter Traces 

The Morning Report Atypicality Analysis window (see Figure 3 . 9 ,  displays a flight’s parameter 
trace relative to the combined parameter traces of other flights in the aggregation. In the example 

represents the flight’s data trace for the selected parameter. The shaded 
oud, represents the combined parameter traces of other flights in the 

positioned inside the parameter clo 
s that contributed to that data regi 

to view the combined traces of the most typical flights (representing 
All 

that contributed to the fli 

to view the combined traces of all flights in the aggregation. 
identifies the most significant characteristic for every parameter 
atypicality ranking. 

Morning Report Pagellof104 

Details Revision: 0.5.1 



APMS 3.0 Flight Analyst Guide 

3.2.5. Other Options 

Fiaure 3.6. Mornina Reoort Atvoicalitv Analvsis Window (Partial View) 

Pitch-Angle maximum slope differs from normal 

The analyst can obtain additional flight information by clicking one of the following: 
0 The Flight Info button 

0 The APMS Viewer button 

links to a table containing the flight’s numerical parameter 
values. 

on a single graph. I 

allows the analyst to view all significant parameter traces 

3.2.6. Va I i date Atypical ity 

The analyst can validate an atypicality by clicking one of the following: 
0 The Flight Validation button 

Section 7.1 of this document). 
atypicalities for the flight. It also allows the analyst to view and validate any special events 
(also known as exceedances) that may have occurred during the flight. 

0 The Quick Validation butto 
to validate an atypicality quic 

launches the Flight Validation tool (described in 
1 allows the analyst to view and validate all phase 

allows the analyst to bypass the Flight Validation tool 

Morning Report 
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4.1. Overview 
The Data Exploration tool allows analysts to conduct in-depth research on a flight. This tool puts 

several other tools and utilities within easy reach, including the Viewer, Parameter Editor, and Loader. 

4.2. Details 
4.2.1. Select Flights 

1 I I 
I 

To select a group of flights in a fleet, select Edit>Select Flights in the menu of the Data 
Exploration window (see Figure 4.1). 

Note: To select only a single flight by its FFD or SFFD identification number, select 
File>Open FFD and navigate to the appropriate file. 

Data Exploration 

Overview Revision: 0.5.1 a 
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In the Select Flights window (see Figure 4.2), perfom the following steps: 
Select the appropriate fleet in the Fleet list box. 
Select the beginning month and year of the que 
Select the ending month and year of the query in the End Date drop-down lists. 

Select the appropriate tail number(s) in the Available Tail Numbers list. 

Note: To select multiple tail numbers, hold down the CTRL key and clic 
To quickly select a contiguous block of tail numbers, hold down the SHIFT key and click the 
first and last items in the block. 

Select flight origin(s) in the Origin list box. 
Note: To select multiple origins, hold down 

Select flight destination(s) in the Destination list bo 
Note: To select multiple destinations, hold down the 

egin Date drop-down lists. 

key and click the desired items. 

ey and click the desired items. 
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To include only those flights that departed one of the selected origin airports and also arrived 
at one of the selected destination airports during a single flight, check the Flight Origin and 
Destination Airports Must Match Selection box. 
Note: If this box is not checked, origin and destin be uncoupled. In other words, the 
query will include all flights leaving the origin airport(s), regardless of destination. It also will 
include all flights arriving at the destination airport(s), regardless of origin. 
When fmished, click OK. 

The Data Exploration window (see Figure 4.3) displays summary information about all of the flights 
that match the flight selection criteria. 
The Data Exploration tool now provides many analysis options for conducting additional research. 
Before choosing an analysis option, first select a single flight. 

4.2.2. Quantify Routine Events 

Data Exploration 

Details 
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To quantify the routine events for a specific flight, select EdiOValidate Data in the menu of the 
Data Exploration window (see Figure 4.4). 

In the Data Exploration window (see Figure 4.5), notice that the Problem Description 
now appears. This column lists the number of routine events identified in the flight. 
ata will result in flights with fewer identified routine events.' 

4.2.3. View Events 

To view a list of all routine events and special events associated with a flight, select Events>All 
Events in the menu of the Data Exploration window (see Figure 4.6). 

Data Exploration 

Details Revision: 0.5.1 a 
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The Flight Information window (see Figure 4.7) provides summary information, phases, special 
events, routine events, and weather associated with the flight. The analyst also can use this window to 
access the Viewer or to obtain flight information from other FFDs or SFFDs. 

4.2.4. Load FFD into Viewer 

To load a flight in the Viewer, select Viewer>Load FFD into Viewer in the menu of the 
Data Exploration window (see Figure 4.8). 

Data Exploration 

Details 
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The Viewer window (see Figure 4.9) now displays a graphical representation of parameter values 
recorded during the selected flight. For a complete description of the Viewer, see Section 0. 

4.2.5. View Parameter Values Grid 

Data Exploration 
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To view a table containing the flight’s parameter values, select Grid>Go to Grid in the 
menu of the Data Exploration window (see Figure 4.10). 

The Flight Data Table (see Figure 4.1 1) lists the value or values for every parameter in a given 
parameter set. To change the parameter set, simply make a new selection in the parameter set drop- 
down list , and then click Go. 

Data Exploration 

Details 
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4.2.6. View Flight in GRADE 

ight in the Graphical Airspace Design Environment (GRADE), select Grade>Go to 
in the menu of the Data Exploration window (see Figure 4.12). GRADE, developed 
, is a PC-based, four-dimensional computer tool for displaying, analyzing, designing, 

Gr 
bY 
and evaluating air traffic operations. 

Data Exploration 

Details Revision: 0.5.1 a 
Page 20 of 104 



APMS 3.0 Flight Analyst Guide 

5.1. Overview 
The Viewer is a powerful tool that allows analysts to study the interactions between significant 

parameters for any flight at any given time during the flight. The Viewer can be accessed only fkom 
other APMS tools, including Morning Report, Data Exploration, and Flight Validation. 

These parameter traces share a common timeline. The Viewer can display parameter traces for any 
parameter recorded in a flight’s FFD (Full Flight Data) or SFFD (Scrubbed Full Flight Data) file. 
The Viewer also can display a flight’s routine events (regular flight occurrences such as Gear Up 
Takeoff and Flaps Down Approach). 

in the Morning Report tool. 

The Viewer produces a graphical representation of multiple parameter values in a single window. 

Analysts use the Viewer as an analytical tool to help validate or invalidate atypicalities displayed 

5.2. Details 
5.2.1. Open FFD File 

Figure 5.1. Viewer Window (Partial View) 

___-l-l__l_ “I 

As mentioned above, the Viewer can be accessed only from other APMS tools. When initially 
opened, the Viewer window displays the FFD or SFFD file that has been selected by the active tool. 

Once the Viewer window has been opened, it can be used to open directly any other available 
FFD or SFFD file. To open an FFD or SFFD file in the Viewer window, select File>Open FFD File 
in the menu and then navigate to the directory containing the appropriate file. 

Viewer Page 21 of 104 
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The Viewer window (see Figure 5.2) now displays a graphical representation of parameter values 
recorded during the selected flight. Notice that the window contains the following items: 

0 A parameter box on the left-hand side that contains a color-coded list of the charted flight 
parameters and their numerical parameter values at the position of the cursor. 

aining separate, color-coded traces of each flight para 

vertically intersect the parameter traces at various intervals. 
0 A combined events locator & timeline scroll bar at the bottom of the window. 

Viewer Page 22 of 104 
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5.2.2. Add Parameters 

Analysts can easily add new parameters to the graph area. To begin, simply right-click inside the 
parameter box and select Add Parameter. 

Viewer Page 23 of 104 
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I 

In the Select New Parameters window (see Figure 5.4), select a parameter in the Generic Name 

rs, hold down the CTRL key and click the desired items. To 
list , and then click OK. 

Note: To select multiple 
quickly select a contiguous block of parameters, hold down the SHIFT key and click the first 
and last items in the block. 

Viewer Page 24 of 104 

Details Revision: 0.5.1 a 



APMS 3.0 Flight Analyst Guide 

5.2.3. Change Parameter Set 

Analysts can easily change the active parameter set. Simply select any available set in the 
parameter set drop-down list. 

Viewer Page 25 of 104 
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5.2.4, Add Routine Event Markers 

Analysts also can add routine event markers to the graph area. Simply click the left panel of the 
5.6). The checked items 
to add new routine event 

events locator bar 
indicate routine e 
markers. 

o display a list of all routine events (s 
active markers. Click items in the list 
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5.2.5. Position Cursor Marker 

Analysts can click anywhere inside the graph area to produce a moveable cursor marker. The 
Time at Cursor from Lift0 
the top of the Viewer window 
time of liftoff and touchdown. The In View display box 
minutes of flight data currently visible in the graph area 
indicate that the cursor marker is at the liftoff position-exactly 4 hours, 5 minutes, and 8 seconds 
from touchdown-and that the entire flight is being displayed in the graph area. 

and Time at Cursor to Touchdown 
gure 5.7) indicate 

indicates the number of hours and 
ample above, the display boxes 

I 
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To reposition the cursor, click and hold while dragging it to a new position. In Figure 5.8, note 
is now positioned 40 minutes fiom touchdown and near to the End 
rker. Also note that numerical values in the parameter list box 

that the cursor marker 
Cruise (CruE) routine 
have changed for all parameters to reflect their values at this new cursor position. 
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To position the cursor over a routine event marker, simply click the’appropriate event fl 
in the events locator at the bottom of the window. In Figure 5.9, note that the cursor marker 
now is positioned directly over the End Cruise (CruE) routine event marker and that the cur 
now is displayed as a white line. 

5.2.6. Set Timeline 
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Analysts can zoom in on a portion of the flight by using the timeline scroll bar at the bottom of the 
window (see Figure 5.10). For example, to zoom in on the End Cruise portion of the flight, click and 
hold on the left scroll hand1 and then drag the scro to the right. Note that the time 
in the Time from Liftoff to 11 Handle display box changes to reflect the new 
position of the left scroll handle. 

In Figure 5.1 1, note that the In View display box 
20 seconds of flight data are visible in the graph area 
minutes and 20 seconds) is represented by the space 
handle. 

now indicates that only 34 minutes and 
that this same amount of time (34 
left scroll handle and the right scroll 
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Analysts can preselect a time slice for viewing data. This is done by manipulating the distance 
between the scroll handles. In Figure 5.12, note that the In View display box 
distance between the left scroll handle and the right scroll handle represents 
that the time slice has been set, analysts can use the following two m 

reveals that the 

a Sliding: Click and hold on the space between the scroll handles, 
bar to the appropriate event or location. 

0 Event centering: Click on the appropriate event flag 
of the window to center on that event. 

then drag the scroll 

in the events locator at the bottom 
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5.2.7. Other Options 

Figure 5.13. Viewer Window (Partial View) 

Other options available in the Viewer include the following: 
: Click this button to automatically load the current Viewer window into 

s button to reset the Viewer window to the default settings. 
Click this button to generate a flight data table containing all of the 

0 Grade>View Flight in Grade : Select this menu option to launch the Graphical 
Airspace Design Environment ). GRADE, developed by ATAC Corp., is a PC-based, 
four-dimensional computer tool for displaying, analyzing, designing, and evaluating air traffic 
operations. 

0 ShowGrid 
I 
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6-1. Overview 
The Search Pattern tool is used to search FFD or SFFD files forpatterns in flight data. By 

identifying patterns associated with specific adverse events in a flight, analysts can better understand 
the causes of these events and, in turn, take actions to prevent them from occurring in the futwe. 

Each pattern consists of one or more modules, or user-defined flight events. Each module is 
composed of at least oneparameter condition, an equation that includes a specific flight parameter, an 
operator, and a numeric value (such as N1-Eng-15 45). Each parameter condition in the module must 
be applied to an eventpame, a selected period of time in a flight. 

For example, to locate all flights that landed with an unstable approach, an analyst might want to 
create a pattern that contains one or more modules for flap position vs. airspeed, one module for high 
speed at landing, one module for low power on approach, and another module for excessive glide 
slope. Each module would be a piece of the pattern that defines an unstable approach. In this example, 
the module for high speed at landing would identify excessive airspeed parameters,(the parameter 
conditions) from the start of the final approach phase until touchdown (the event frame). 

flights that match any of the modules in the pattern. Analysts then can conduct additional research on 
the characteristics of matching flights or refine the pattern definition for fbture queries. Analysts also 
can make use of other APMS tools for M e r  analysis. 

When an analyst runs a pattern, the Search Pattern tool queries the database and returns a list of 

6.2. Details 
6.2.1. Create New Pattern 

Figure 6.1. Search Pattern Window (Partial View) 

To begin a new pattern, select File>Pattern ManagementX3imple in the menu of the 
Search Pattern window (see Figure 6.1). 

Note: The Search Pattern tool includes a simple mode and an advanced mode. This document 
describes only the simple mode. 

Search Paltern (Simple Mode) 
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The Pattern Wizard window (see Figure 6.2) lists all previously created patterns in the Available 
Patterns drop-down list 
modules. It also lists ro 
selected). 

The Available Modules list box 
s (when the Include Routine Ev 

Note: A pattern consists of one or more modules. A module is a user-defined flight event 
composed of one or more parameter conditions (such as N1-Eng-1-corr 5 45), applied to a 
specific time frame (such as Ten Minutes before Touchdown). 

Figure 6.3. Pattern Wizard Window (Partial View) 

To create a pattern, select New>Pattern in the menu of the Pattern Wizard Window 
(see Figure 6.3). 

Search Pattern (Simple Mode) 
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In the Editor window (see Figure 6.4), enter a name for the new pattern in the text field 
and then click OK. 

24000 ft QN H Approach 

2500 ft AFE Approach 
260 kts Takeoff 

45 KlAS Rollout 
500 ft AFE Approach 
60 KlAS Rollout 
80 KlAS Rollout 
8000 ft QNH Approach 

In the Pattern Wizard window (see Figure 6.5), select the new pattern in the Available Patterns 
drop-down list 
by the empty P 
any pattern-defining modules. 

. Note that the 
etails list box. 

ern is only an empty shell at this stage, as evidenced 
In other words, the new pattern does not yet contain 

Search Pattern (Simple Mode) 
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Add Existing Modules to New Pattern 

To add existing modules to a new pattern, simply drag and drop items from the Available 
Modules list box 
Figure 6.6). 

to the Pattern Details list box in the Pattern Wizard window (see 

To view the details (parameter conditions and event frame) associated with a particular module, 
simply click on an item in the Available Modules list box. 
Module Description list box. 

The details will appear in the 

6.2.2. Create New Module 

Fiaure 6.7. Pattern Wizard Window (Partial View) 

I 1 Flaps 30 vs speed I o  
To create a new module, select New>Module a in the menu of the Pattern Wizard 

window (see Figure 6.7). 

Search Pattern (Simple Mode) 
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In the Define New Module (Description) window (see Figure 6.8), perform the following steps: 
Type a name for the module in the Name field 
Type an abbreviation for the module in the Ab 

SpeciQ the risk level in the Risk Index field. 
Note: The Risk Index is an analyst-assigned risk level for each module in a pattern. This 
numerical value allows analysts to weight the relative degree of risk fiom the combined 
parameter conditions included in the module. A larger number indicates a greater risk. The 
Risk Index is used to compute the lUN for every flight that matches a pattern. Currently, there 
is no default Risk Index value range in APMS. 

n field. 

When finished, click the >> button or the When to Look tab. 

Search Pattern (Simple Mode) 
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In the Define New Module (When to Look) window (see Figure 6.9), perform the following 
steps: 

0 Click a radio button for one of the following event frame categories: 

Defined Phases: Contains only APMS-defined phases (such as Cruise). 
Defined Event F Contains all previously used event frames, 

User Defined: 

including custom time p ated in the advanced mode of Search Pattern. 
Contains routine event markers (such as Taxi Out) 

Note: An event frame is a selected moment or span of time in a flight. An event frame can be 
an APMS-defined phase (such as Cruise), a user-defined time period based on routine event 
markers (such as Taxi Out to Liftoff), or a custom time period created in the advanced mode of 
Search Pattern (such as 1500 ft  AFE Approach to Touchdown). The amount of time 
represented by an event fiame can be as short as a single second (such as Center of Flight) or 
as long as the entire flight. 

0 Select the appropriate event frame in the active drop-down list. If using the User Defined 
category, select a routine event in each of the two drop-down lists. 

0 When fmished, click the >> button or the What to Look For tab. 

Search Pattern (Simple Mode) 
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In the Define New Module (What to Look For) window (see Figure 6.10), click Add 
Condition. 

Search Pattern (Simple Mode) 
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Add Existing Condition to New Module 

Figure 6.1 1. Available Conditions Window Figure 6.1 1. Available Conditions Window 

The Available Conditions window (see Figure 6.1 l), provides a list of all previously created 
parameter conditions. To add an existing condition to the module, simply click a condition in the 
list , and then click OK. 

Search Pattern (Simple Mode) 
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, 

Notice that the added condition 
For) window (see Figure 6.12). 

now appears in the Define New Module what to Look 

Search Pattern (Simple Mode) 
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Create New Condition 

To create a new condition, click Add Condition in the Define New Module (What to 
Look For) window (see Figure 6.13). 

Search Pattern (Simple Mode) 
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Figure 6.14. Available Conditions Window Figure 6.14. Available Conditions Window 

Position the cursor inside the Available Conditions window (see Figure 6.14), right-click, and 

dition has been created, it cannot be deleted in the simple mode of Search 
then select New. 

Pattern. To delete a condition, use the advanced mode. 

Figure 6.15 Create New Condition Window 

In the Create New Condition window (see Figure 6.15), perform the following steps: 

0 Select a parameter from the drop-down list. 

Note: Derivedparameters are not available 
new condition based on derived parameters, use the advanced mode. 

0 Select an operator from the drop-down list. 
0 Type a value into the text field. 

le mode of Search Pattern. To create a 

Search Pattern (Simple Mode) 
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0 ClickOK. 

Add Second Condition to New Module 

Figure 6.16. Available Conditions Window 

1 

When adding a second condition to a module, the analyst is required to join them by setting the 
condition 
click OK 

Fiaure 6.17. Set Condition Loaic Window 

add a second condition to the module, select the condition in the list and 
the Available Conditions window (see Figure 6.16). 

The Set Condition Logic window (see Figure 6.17) appears only when a second condition has 
been added. Even though multiple conditions can be added to a module, the module logic is selected 
only one time. Click AND ire that all of the module conditions exist in order to 

Search Pattern (Simple Mode) 
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generate a query match. Click OR 
order to generate a query match. 

to require that only one of the module conditions exist in 

Save New Module 

Selected conditions and logic will appear in the display area 
(What to Look For) window (see Figure 6.18). When all condi 

of the Define New Module 
e been added, click 

Done. 

Search Pattern (Simple Mode) 
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Figure 6.19. Pattern Wizard Window 

.-Airspd-Computed-Corr >= 20 

Initial Power Application 

In the Pattern Wizard window (see Figure 6.19), the new module now appears in the Available 
Modules list box. 
Section 6.2.1, Cre Pattern. 

The module now can be added to a pattern, as described previously in 

Note: Once a module has been created, it cannot be edited in the simple mode of Search 
Pattern. To edit a module, use the advanced mode of Search Pattern. 

6.2.3. Run New Pattern Query 

Figure 6.20. Search Pattern Window (Partial View) 

Analysts can query the APMS database to frnd flights that match a pattern. To run a new pattern 
query, click Run Pattern in the Search Pattern window (see Figure 6.20). 

Search Pattern (Simple Mode) 
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In the Run Search Pattern window (see Figure 6.21), perform the following steps: 
Select the appropriate fleet in the Fleets list box. 
Select the beginning month and year of the query 

Select the ending month and year of the query in the End Date drop-down lists. 
Select the appropriate tail number(s) in the Available Tail Numbers list 
Note: To select multiple tail numbers, hold down the CTRL key and clic 
To quickly select a contiguous block of tail numbers, hold down the SHIFT key and click the 
first and last items in the block. 
Select flight origin(s) in the Origin list box. 

Note: To select multiple origins, hold down 
Select flight destination(s) in the Destination list box. 
Note: To select multiple destinations, hold down the 

Begin Date drop-down lists. 

and click the desired items. 

Search Pattern (Simple Mode) 
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By default, searches will locate only flight tail numbers that departed the selected origin 
airport(s) and arrived at the selected destination airport(s) during a single flight. To search for 
all tail numbers leaving the origin airport@) regardless of destination(s), and all tail numbers 
arriving at the destination airport(s) regardless of origin airport(s), uncheck the Flights Origin 
and Destination checkbox. 
Select the appropriate patte 

Click Go. 

attern list box. 

The Search Pattern Progress window (see Figure 6.22) tracks the query progress and identifies 

The query results will appear when processing is complete. See Section 6.2.5, Interpret Pattern 
the flights matching the properties of the selected pattern. 

Results, to learn more about interpreting the results. 

Search Pattern (Simple Mode) 
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6.2.4. Open Existing Pattern Query 

Figure 6.23. Search Pattern Window (Partial View) 

In addition to running new pattern queries, the analyst also can access the results of prior pattern 
queries. To open an existing query, click Pattern Results 
(see Figure 6.23). 

in the Search Pattern window 

Figure 6.24. Run Patterns Window 
I 

In the Run Patterns window (see Figure 6.24), select a pattern query 
The query results will appear immediately. See Section 6. 
bout interpreting the results. 

View 
to lea 

ret Pattern Results, 

Search Pattern (Simple Mode) 

Details Revision: 0.5.1 

Page 49 of 104 



APMS 3.0 Flight Analyst Guide 

6.2.5. Interpret Pattern Results 
The Search Pattern window (see Figure 6.25) allows analysts to view a complete list of FFDs or 

SFFDs that match at least one module in the pattern. This window contains two tabbed pages: Pattern 
Results and Individual Results. These options are described below. 

Pattern Results 

Fiaure 6.25. Search Pattern Window (Pattern Results Table) 

1 
Analysts use the Pattern Results table (see Figure 6.25) to determine the flights they wish to 

examine in more detail. The Pattern Results table contains a row for every matching 
begins with the Flight column, which contains the flight’s unique FFD or SFFD numbe 
table also contains a separate column for every module associated with the applicable p 
The numbers in these c resent the time, in seconds, at which the module occurred d 
flight. The RIN column contains an APMS-computed number that is displayed for every 
flight that matches a p RIN is the sum of the risk indices for the modules that occurred 
during a flight. A larger RIN indicates a greater risk. The RIN allows analysts to quickly sort the 
results based on the severity of the modules that occurred during a flight. 

Individual Results 

The Individual Results table, (see Figure 6.26) summarizes each module that occurred in a 
specific flight. In addition to the information available in the Pattern Results table, the Individual 

Search Pattern (Simple Mode) 
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Results table contains a Duration column. 
given module. 

To obtain additio 
Flight Information. 

This column lists the duration, in seconds, of a 

ation about a flight, right-click on the appropriate record, then select 

Destination Airports : 
Destination Runway : 
Fleet : Airlines B737 

i 

Results table contains a Duration column. 
given module. 

This column lists the duration, in seconds, of a 

To obtain additional information about a flight, right-click on the appropriate record, then select 
Flight Information. 

Figure 6.27. Flight Information Window 

Destination Airports : 
Destination Runway : 
Fleet : Airlines B737 

i 

The Flight Information window (see Figure 6.27) provides summary information, phases, special 
events, routine events, and weather associated with the flight. The analyst also can use this window to 
access the Viewer or to obtain flight information from other FFDs or SEFDs. If research indicates that 
the events associated with a flight contain bad data, the analyst can use the Set Bad Data drop-down 

the Summary tab to mark the data as good or bad. The analyst can set data markers for 
or for all flights associated with an aircraft tail number. 

Note: Flights that have been flagged with a bad data marker will not be used as baseline flights 
for computing atypicality. In other words, the Analysis Engine will not include these flights in 
an aggregation used to determine typical flight patterns. 

Search Pattern (Simple Mode) 
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7.1. Overview 
The Event Charts tool displays report pages containing routine event charts for a selected group of 

flights. Each event chart is associated with one parameter and uses routine events to plot the 
parameter distributions. The charts contained on a report page allow an analyst to evaluate and 
compare parameter distributions at selected routine events within a group of flights. 

following entities: 
Before generating and viewing report pages, the flight analyst must first create and define the 

Page Group: Category-specific container for pages. Parent directory in tree structure. Created 
in the Page Manager box. 
Page: Category-specific container for charts. Defines the routine events, page title, and page 
layout for all associated charts. Sub-level directory ofpage group parent. Created and defrned 
in the Page Manager box. 
Chart: Defines the parameter, chart style, chart title, and axis limits for a shgle chart. Sub- 
level directory ofpage parent. Created and defined in the Page Manager box. 
Query Folder: Category-specific container for queries. Parent directory in tree structure. 
Created in the Queries box. 
Query: Defines the query name, fleet(s), begin date, end date, tail number(s), origin airport@), 
and destination airport(s) for a single query. Sub-level directory of queryfolder parent. Created 
and defined in the Queries box. 

Event Charts 
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7.2. Details 
7.2.1. Create Page Group 

Figure 7.1. Event Charting Window 

To create a page group, click the Page Manager tab in the Event Charting window (see 
Figure 7.1). 

Event Charts 
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In the Event Charting window (see Figure 7.2), perform the following steps: 
0 Position the cursor inside the white area of the Page Manager box. 

0 Right-click the mouse. 
0 Click Add Group in the menu box. 

Figure 7.3. Page Group Name Wndow 

In the Page Group Name window (see Figure 7.3), enter a name for the new page group in the 
text field , and then click OK. 

Event Charts 
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Page to Page Group 

To add a page to a page group, click the Page Manager tab 
window (see Figure 7.4), and then perform the following steps: 

in the Event Charting 

0 In the Page Manager box, click the page group that will contain the new page. 

0 Right-click the mouse. 
0 Click Add Page in the menu box. 

Event Charts 
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Figure 7.5. Page Properties Window 

In the Page Properties window (see Figure 7 . 9 ,  perform the following steps: 
a Enter a name for the new page in the Page Name text field. 
a Click on a pertinent routine event in the Routine Events lis 

0 Click the >button 

0 Select additional r 
a When finished, click OK. 

ents in the Routine Events list, as necessary. 

Event Charts 
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7.2.3. Add Chart to Page 

Figure 7.6. Event Charting VVndow 

I%.. Routine Events 

.. ............................................. 

To add a chart to a page, click the Page Manager tab in the Event Charting window 
(see Figure 7.6), and then perform the following steps: 

0 In the Page Manager box, click the page that will contain the new chart. 

0 Right-click the mouse. 
0 Click Add Chart in the menu box. 

Event Charts 
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Fiaure 7.7. Chart ProDerties Window 

In the Chart Properties window (see Figure 7.7), perform the following steps: 
Enter a name for the new chart in the Chart Title text field. 
Enter a display name for the new chart in the Display Title 

Select a chart type (spline or histogram) in the Chart Type drop-do 

Select the appropriate parameter in the Parameter Name drop-down list. 
Enter the appropriate values in the Min Bin Value, Max Bin Value, and 
fields. 
Note: 
entering minimum and maximum bin values. If necessary, come back and adjust the values 
after viewing the chart. 
Click Re-calculate Axis Labels. 

arting a parameter that is unfamiliar, simply make a rough estimate when fxst 

Event Charts 
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0 To allow the creation of extra bins to collect flights with values less than the Mitl Bin Value 
and greater than the Max Bin Value, click the Can Underflow and Can Overflow 
boxes. 
Note: Can Underflow and Can Overflow boxes are not checked, flights with 
values less than the Min Bin Value and greater than the Max Bin Value are placed in the 
nearest available bins. 

0 When fmished, click Save. 

7.2.4. Create Query 

Fiaure 7.8. Event Chartina Window 

To create a query, click the Queries tab in the Event Charting window (see Figure 7.8). 

Event Charts 
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In the Event Charting window (see Figure 7.9), perform the following steps: 
0 Position the cursor inside the white area of the Queries box. 

0 Right-click the mouse. 
0 Select Add Folder>Root Folder in the menu box. 

Event Charts 
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Figure 7.10. Event Charting Window 

In the Event Charting window (see Figure 7. lo), perform the following steps: 
0 Click the newly created folder in the Queries box. 

Note: The query folder can be given a new name at any time. To do this, simply double-click 
on the folder title and enter an appropriate name. 

0 Right-click the mouse. 
0 Select Add Query in the menu box. 

Event Charts 
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In the Flight Query Data Selection window (see Figure 7.1 l), perform the following steps: 
Enter a name for the new query in the Query Name text field. 
Select the appropriate fleet in the Fleet list. 
Select the appropriate starting month and y 

Note: By default, this date will reflect the earliest month for which there is data 
selected fleet. 
Select the appropriate ending month and year in the End Date drop-down lists. 
Note: By default, this date will reflect the latest month for which there is data for the selected 
fleet. 

Begin Date drop-down lists. 

Select the appropriate tail number(s) in the Available Tail Numbers list. 
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Note: To select multiple tail numbers, hold down the CTRL key and click the desired items. 
To quickly select a contiguous block of tail numbers, hold down the SHIFT key and click the 
first and last items in the block. To quickly select all tail numbers, click the Select All Tail 
Numbers box. 

Select the appropriate origin airport(s) in the Origin list. 

Note: To select multiple origin airports, hold down the 
To quickly select all airports, click the Select All box. 

Select the appropriate destination airport@) in the Destinatio 

Note: To select multiple destination airports, hold down the C 
items. To quickly select all airports, click the Select All box. 
To include only those flights that departed one of the selected origin airports and also arrived 
at one of the selected destination airports during a single flight, check the Flight Origin and 
Destination Airports Must Match Selection box. 
Note: If this box is not checked, origin and destin be uncoupled. In other words, the 
query will include all flights leaving the origin airport(s), regardless of destination. It also will 
include all flights arriving at the destination airport(s), regardless of origin. 

and click the desired items. 

and click the desired 

When finished, click OK. 

7.2.5. Run Report 

Figure 7.12. Event Charting Wlndow 

Event Charts 
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To run a report and view charts, click the Page Manager tab in the Event Charting 
window (see Figure 7.12). 

Figure 7.13. Event Charting Window 

E Airspeed (Page Group) 

In the Event Charting window (see Figure 7.13), perform the following steps: 
0 Click the thumbnail icon in the Page Manager box. 

Note: The thumbnail icon should now be pointing do 
box is locked on the page. 

indicate that the Page Manager 

0 Click the Queries tab. 
0 Click the thumbnail ic Queries box. 

Event Charts 
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Figure 7.14. Event Charting Window 

In the Event Charting window (see Figure 7.14), perform the following steps: 
In the Queries box, check the tick box beside the folders (to include q11 queries in the folders) 
or individual queries to be included in the report. 
In the Page Manager box, click the appropriate (to include all existing charts for 
every page in the group), page (to include all existing charts for that page), or individual chart 
to be displayed. 
Click the thumb 
Click the thumbnail icon in the Page Manager box to dock 
Note: Docking the Queries and Page Manager boxes leav 

in the Queries box to dock the box. 

ender the charts. 

Click Run Report. 

Event Charts 
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7.2.6. View Charts 

Fiaure 7.15. Event Chartina Window 

In the Event Charting window (see Figure 7.15), choose any of the following options: 
0 To export chart(s), select File>Export>PowerPoint or File>Export>Excel in the 

menu 

0 Tozo a single chart, right-click inside the chart and then select Zoom Chart. 

Note: This feature operates as a toggle. To return to the default view, simply click Zo 
Chart again. 

0 To produce separate charts for each routine event, right-click inside the chart and then select 
Split Chart in the menu box. 

Event Charts 
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To produce a list of all flights occupying a specific data point, right-click on the data point and 
then select Chart Data>Flights in Data Exploration in the menu box. 

To produce a table that contains the total number of flights in each bin 
right-click inside the chart and then select Chart Data>Raw Data 

d download an image file of a chart, click on the appropriate chart and then 
select Save Chart Image to File ... in the menu box. 
To quickly edit the properties of a chart, click on the e chart and then select Edit 
Chart in the menu box. 

Event Charts 
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8A. Overview 
The Flight Validation tool allows a flight analyst to view all special events, routine events, and 

atypicalities associated with a flight and to validate or invalidate the record based on additional 
research. The analyst can filter the results to view only records with specific characteristics. After 
researching an event or atypicality, the analyst can produce a validation form and select the 
appropriate validation status. 

8.2. Details 
8.2.1. Select Fleet 

Flight Validation 
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The flight analyst first must select a fleet in the Flight Validation window (see Figure 8.1). To do 
this, select a fleet in the Fleet drop-down list , and then click Refresh Flight List. 

8.2.2. View Flight List 

Once a fleet is selected, the Flight List box 
in the Flight Validation window (see Figure 8. 

is populated with summary flight information 
arch for a specific flight that is not visible, 

click Page Down. 

Flight Validation 
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8.2.3. Filter Flight List 

Fiaure 8.3 Fliaht Validation Window (Partial View) 

Analysts can filter the flight list to display only those records that match specific categories. By 
marking the check boxes next to Actions, 
Validation window (see Figure 8.3), the 

in the Flight 

The Actions list 
particular action ite 
the actions options 
described in greater detail in Section 8.2.7, Validate Selection.) 

allows the analyst to restrict the view to only records coded with a 
s Investigation or Maintenance). The options in this list correspond with 

the Validation window (see Figure 8.1 1). (The Validation window is 

allows the analyst to restrict the view to only records that contain special 
r above the selected level. For example, to restrict the view to only mid- 

Note: Level 0 items are low-priority special events identified by SAGEM Avionics, a company 

The Status list 

severity Level 2 items and high-severity Level 3 items, select 2. 

that preprocesses digital flight data. 

particular validati 
allows the analyst to restrict the view to only records coded with a 
such as Confirmed or Pending). The status options in this list also 

Flight Validation 

Details Revision: 0.5.1 

Page 71 of 104 



APMS 3.0 Flight Analyst Guide 

correspond with the validation status options available in the Validation window (see Figure 8.1 1). 
(The Validation window is described in greater detail in Section 8.2.7, Validate Selection.) 

8.2.4. Select Flight 

In the Flight Validation window (see Figure 8.5), click on a flight 
s been selected, all associated special 

to select it in the 
11 appear in the 

and all associated atypicalities will appear in the Analysis List Special Events tab1 
e described below. 
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8.2.5. View Special Events & Routine Events 

The Special Events table (see Figure 8.6) displays event status, event description, event level, 
event time in flight, flight phase, and event duration for every special event associated with the flight. 

To view the flight’s routine events, click the Routine Events tab. I 

Fiaure 8.7. Routine Events Table (Fliaht Validation Window) 

itial Power Application 587 

The Routine Events table (see Figure 8.7) displays the event time for the flight’s routine events. 
This allows an analyst to reference special events to the time of routine events in a flight. 
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8.2.6. View Analysis List & Analysis Details 

Fiaure 8.8. Analvsis List Table (Fliaht Validation Window) " . "  " . "  
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The Analysis List tab (see Figure 8.8) displays the global atypicality level, atypicality analysis 

To view the details associated with an atypicality, select the appropriate iecord 
status, analysis date, and event level for every phase atypicality associated with the flight. 

click the Analysis Details tab. 

Fiaure 8.9. Analvsis Details Table (Fliaht Validation Window) 

, and then 

average value is more nose down than normal 
slope is less neg 
value is Iowerth 

"" 
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The Analysis Details table (see Figure 8.9) displays parameter names and rationale descriptions 
for every atypicality associated with the flight. 

Flight Validation 

Details Revision: 0.5.1 a 
Page 74 of 104 



APMS 3.0 Flight Analyst Guide 

8.2.7. Validate Selection 

Analysts can use the Viewer tool to perform additional research on special events and 
atypicalities. To open the Viewer fiom the Flight Validation window (see Figure S.lO), simply select 
a flight in the Flight List box, then click Send to Viewer. 

assign the proper validation status 
to every special event and atypicality. To do this, simply double-click the special event or atypicality 
item in the appropriate table 
corresponding Validate Ev 

Once the analyst has sufficiently researched a flight, 

or select the special event or atypicality and click the 
or Validate Analysis button. 
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Fiaure 8.1 1. Validation Window 

I 

5/24/2004 hase yplcallty 

In the Validation window (see Figure 8.1 l), select one of the following options in the Validation 
Status box: 

0 Vali 

0 Validation Pending: Record has not been reviewed. 
0 Validated: Record is valid with a confirmed or exempted disposition. 
0 Invalidated: Record contains bad data, or the special event or atypicality has been badly 

defined. 
0 Refer For Second Opinion: Event or analysis will be flagged so that it can be recalled and 

evaluated later by a second analyst. 

eferred: Record status is uncertain and will be revisited. 

In addition, analysts can select one or both of the following choices in the Actions box: 

Flight Validation 
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0 Maintenance: Maintenance is needed on the aircraft associated with this flight. 
0 Investigation: An investigation needs to be performed for this event. 

To add comments to a validation record, simply enter text into the empty field 
click Add New Comment. 
user name and date of e 

The comment will appear in the Comments 
added automatically to the record. 

When all the information has been entered for the validation record, click Save and Close 
to save the validation record and exit the Validation window. 

The validated record now will be updated in the Flight Validation window (see Figure 8.12). 
Note that Status column 
and that the comment bo 

the Analysis List table has been updated to “Confirmed” status, 
also has been updated. 

Flight Validation 
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9 . t  Overview 
The Reports tool allows analysts to create custom graphs and statistics tables fiom flight data. 

Users first build templates, and then create reports based on the templates. The Reports tool actually 
consists of two separate tools that use a similar design: 

0 The Performance Report tool generates reports fiom parameter data in the Full Flight Data 
(FFD) or Scrubbed Full Flight Data (S'FFD) file. Analysts group flights by phase (or 
segment), fleet, date, and airport. Graph outputs include bar charts, line charts, area charts, and 
histograms. Analysts use this tool to determine the overall pattern of performance for an entire 
group of flights. 
Note: At this time, the Performance Report tool plots only distance data on the x-axis. For this 
reason, the tool is most useful for analyses of takeoffs and landings. 

0 The Special Event Report tool generates reports fiom a flat file of special events, or 
exceedances. Analysts use this tool to evaluate the numbers and rates of special events and to 
make comparisons with other flights. 

The Performance Report and Special Event Report tools will be described separately, with an 
introductory section that describes set-up details common to both tools. 
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9.2. Set-up Details 
9.2.1. Log In 

Fiaure 9.1. Reoorts Loain mndow 

APMS Reports Login 

User Name 

Unlike other APMS tools, the Reports tool opens with its own Login window (see Figure 9.1). 
Simply type the appropriate information into the User Name 
and then click Login. 

and Password fields, 

Note: A user name and password will be provided by the system administrator. 
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9.2.2. Create User Category 

Analysts must create a user category before beginning work in either the Performance Reports tool 
or the Special Events report. To create a user category, click Manage Categories 
Reports Home Page window (see Figure 9.2). 

in the 
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In the Report Categories window (see Figure 9.3), type a user 
and select a permissions level from the Permission drop-down box 
create the user category. 
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9.3. Performance Report Details 
9.3.1. Create New Template 

Analysts first build templates, and then create performance reports based on the templates. 
Performance report templates define the specific flight phase (or segment) to be analyzed. They also 
allow the analyst to defme the type of output (such as a bar chart or histogram) for a report. To create 
a template, click Create Templates 
window (see Figure 9.4). 

in the left-side menu of the Reports Home Page 
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Figure 9.5. Create Performance Report Templates Window 

I 

In the Create Performance Report Templates window (see Figure 9.9,  follow these steps to 
create a template: 

0 Type a name for the template in the Template Name field. 
0 Select the appropriate user category in the Template Category drop-down list. 
0 Select the desired flight phase (or segment) to analyze in the Report Type dro 
0 Select the desired graph type in the Graph Type drop-down list. 
0 To overwrite the default routine event marking the start of select 

event in the Starting Marker drop-down list. 
0 To overwrite the default routine event mark 

select a new routine 

of selected phase, select a new routine 
event in the Ending Marker drop-down list. 
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0 Click Add Segment to add a phase to the template. 
Report Segments box. 

The phase should appear in the 

0 If desired, add addition to the template. 
0 When finished, click Create Templat 

template list at the bottom of the page. 
Note: Templates can be edited for hture revision. 

The new template should appear in the 

9.3.2. Create New Report 
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A performance report can be built on any template that is available in the Create Performance 
Reports window (see Figure 9.6). To create a report, follow these steps: 

Click Select for the appropriate template in the Report Template list. 

Type a name for the report in the Report Name field. 
Select the appropriate user category in the Report Ca 

Select arriving flights, departing flights, or all flights in the Operation drop- 

Select the appropriate fleet in the Fleet drop-down list. 
Select one or more airports in the Airports scroll list. 
Select the start date in the Starting Date calenda 

Select the end date in the Ending Date calendar. 
When finished, click Run Now. 

Note: Reports cannot be edited once they have been created. 
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9.3.3. View Report 

Figure 9.7. Performance Report Window 
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The report results will appear in the Performance Report window (see Figure 9.7). Click Add to 
PowerP 
Discard 

to automatically load selected charts into a Powerpoint document. Click 
remove the entire report fiom the reports archive. 

To view additional report details, click View Reports. 
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Figure 9.8. View Performance Reports Window 

I 
Filter reports by category No Filter 

The View Performance Reports window (see Figure 9.8) displays a list of all saved reports. To 
view all details of a report, click Select 
Details. 

for the appropriate report, and then click Report 

Note: To create a zipped file containing graphics, statistics, and XML files for this report, simply 
click Download. 
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gure 9.9. View Performance Report Details Wlndow 
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The View Performance Report Details window (see Figure 9.9) allows the analyst to view all 
details of a report. To view a graph that combines the plots from two or more charts, click 
Combined 
table, click 

To view X M L  data for the report, click XNIL File. To view a statistics 
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9.4. Special Event Report Details 
9.4.1. Create New Template 

Analysts first build templates, and then create special event reports based on the templates. Special 
event report templates define the specific events and phases to be analyzed. They also allow the 
analyst to chart the output by event, status, airport, month, or year. To create a template, click Create 
Templates in the left-side menu of the Reports Home Page window (see Figure 9. lo). 
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Figure 9.1 1. Create Special Event Report Templates Window 

In the Create Special Event Report Templates window (see Figure 9.1 l), follow these steps to 
create a template: 

0 Type a name for the template in the Name field 

0 Select the appropriate user category in the Cate -down list 

0 Select the desired measuring unit (counts or rate) for the x-axis in th re drop-down 
' list. 

Sel sired chart type (line or bar) in the Format drop-down list. 
Select the data category (event, airport, status, month, or year) for the y e Charted by 

r of items to chart for the y-axis category in the Top Items drop- 
ample, if the data category in the Charted by list is Airport, a 

selection of 5 in the Top Items list will chart results for the five most active airports. 
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Select the data category (individual event, individual airport, individual status, individual 
month, individual year, total events, or total airports) in the Separated by drop-down 
list. For example, select Individual Month to produce a separate chart for each month. 

levels (all, levels 2 and 3 only, or level 3 only) in the Event Levels 

in the Events drop-down list. 
Select any or all phases in the Phases drop-down list. 
When finished, click Add. The new templat 
bottom of the page. 

Note: Templates c 

ear in the template list at the 

ed for future revision. 

I '  
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9.4.2. Create ew Report 

Figure 9.12. Create Special Event Reports Window 

I 
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A special event report can be built on any template that is available in the Create Special Event 
Reports window (see Figure 9.12). To create a report, follow these steps: 

0 Click Select for the appropriate template in the Report Templates list. 

0 Type a name for the report in the Report Name field. 
0 Select the appropriate user category in the Report Ca 

0 Select the appropriate fleet in the Fleet drop-down list. 

0 Select arriving flights, departing flights, or all flights 
0 Select one or more airports in the Airports scroll list. 
0 Select the start date in the Starting Date calend 
0 Select the end date in the Ending Date calendar. 

0 When finished, click Create 

Note: Reports cannot be edit 

ration drop-down list. 

ey have been created. 
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9.4.3. View Report 

Figure 9.13. Special Event Report Window 
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The report results will appear in the Special Event Report window (see Figure 9.13). Click Add 
to automatically load selected charts into a Powerpoint document. Click 
ove the entire report from the reports archive. 

ort details, click View Reports. 
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View Special Event Reports I 

The View Special Event Reports window (see Figure 9.14) displays a list of all saved reports. To 
view all 
Details. 

f a  report, click Select for the appropriate report, and then click Report 

Note: To create a zipped file containing graphics, statistics, and XML files for this report, simply 
click Download. 
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gure 9.15. View Special Event Report Details WIndow 
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The View Special Event Report Details window (see Figure 9.15) allows the analyst to view all 
details of a report. To view the next graph in the series, click Next. 
a new or existing PowerPoint documen to PowerPoint 
report criteria, click Show Graph Info view a statistic 
To add the entire report to a new or exi 
PowerPoint. 

o add the visible chart to 
To view template and 

erPoint document, click Add Report to 
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Term 
Aggregation 

Analysis Engine Tool 

Analysis Report 

APMS 
Atypicality 

Cartridge 

Data Exploration Tool 

Derived Parameter 

A group of new and existing flights (typically totaling 1,000) used 
by the Analysis Engine to produce an analysis report. Flights from 
the same fleet (and, if applicable, from the same originating or 
destination airport) are grouped to form an aggregation. The 
Analysis Engine then compares the flights by phase to determine the 
most atypical flights in the aggregation. 
An APMS utility that uses internal algorithms to identi& typical 
patterns and atypical flights represented in bodies of digital flight 
data. Because it operates without any prior human specification of 
normal or operationally interesting flight patterns, the Analysis 
Engine can reveal unexpected events or trends that could 
compromise the safety of flight operations. This utility produces the 

A report generated either manually or automatically by an APMS 
utility called the Analysis Engine. This report identifies atypical 
flights and atypical flight phases. It is displayed by the Morning 
Report tool. 
NASA’s Aviation Performance Measuring System. 
An anomaly in the digital flight data for a specific flight or phase of 
a flight. The Morning Report tool is used to view the atypicalities 
identified by the Analysis Engine utility. 
A removable disc that stores digital flight data. A cartridge usually 
contains data from multiple flights of a single aircraft. Cartridges are 
identified by aircraft tail number and date of last recorded data. 
An APMS tool that allows analysts to conduct in-depth research on 
a flight. It contains links to other tools and utilities, including the 
Viewer, Parameter Editor, and Loader. 
A custom parameter that is defined by the user and generated within 
APMS. A derived parameter is frequently based on a mathematical 
equation and the values from other flight parameters. For example, 
an aircraft’s potential energy can be derived at any given moment of 
the flight by multiplying its gross weight parameter value by its 
altitude parameter value. 
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Term 
Event Charts Tool 

Event Frame 

Exceedance 
FFD File 

Fleet Editor Utility 

Flight Validation Tool 

FOQA 

Generic Parameter Name 

Global Atypicality 

An APMS tool that report pages containing routine event charts for 
a selected group of flights. Each event chart is associated with one 
parameter and uses routine events to plot the parameter’s 
distributions. The charts contained in a report page allow an analyst 
to evaluate and compare parameter distributions at routine events 
within a group of flights. 
A selected moment or span of time in a flight. An event frame can 
be an APMS-defined phase (such as Cruise), a user-defined time 
period based on routine event markers (such as Taxi Out to Liftoff), 
or a custom time period created in the advanced mode of Search 
Pattern (such as 1500 ft  AFE Approach to Touchdown). The time 
represented by an event fiame can be as short as a single second or 
as long as the entire flight. 
See Special Event. 
Full Flight Data file. A complete set of flight data for a single flight. 
This unfiltered file contains all parameter vqlues from takeoff to 
touchdown. The APMS Loader utility creates a separate FFD file for 
each flight while importing raw flight data. 
An APMS data importation utility. For more information, see the 
APMS 3.0 System Administrator’s Guide. 
An APMS tool that allows a flight analyst to view all special events, 
routine events, and atypicalities associated with a flight and to 
affirm or invalidate the record. 

~~ ~ 

Flight Operational Quality Assurance team. These aviation-safety 
analysts review data recorded during flight to improve the safety of 
flight operations, air traffic control procedures, and airport and 
aircraft design and maintenance., 
A parameter that has been given a standardized name within APMS. 
Prior to importation to APMS, digital flight data contain parameter 
names that vary depending on the particular airline, fleet, or 
recording device. APMS programmers assign a common parameter 
name to each parameter to enable cross-fleet analyses. Generic 
parameter names are for internal APMS use only. 
An anomaly in the digital flight data associated with a specific 
flight. A flight with global atypicality contains one or more phases 
with parameters that vary fiom those of other related flights. The 
Analysis Engine utility identifies flights with global atypicality and 
ranks the degree of variance. A flight can have only one global 
atypicality ranking per analysis report. Analysts use the Morning 
Report tool to identifl flights with global atypicality. 
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GRADE 

Invalidated Atypicality 

Invalidated Special Event 

Level 1 Atypicality 

Level 2 Atypicality 

Level 3 Atypicality 

Level 1 Special Event 

Level 2 Special Event 

Level 3 Special Event 

Loader Utility 

Module 

Graphical Airspace Design Environment. GRADE, developed by 
ATAC Gorp., is a PC-based, four-dimensional computer tool for 
displaying, analyzing, designing, and evaluating air trafic 
operations. The Viewer and Data Exploration tools contain a link to 

An atypicality that has been rejected and flagged as invalid by a 
flight analyst. This designation usually indicates that the atypicality 

A special event that has been rejected and flagged as invalid by a 
flight analyst. This designation usually indicates that the special 
event resulted fkom bad data. 
An atypical flight or phase with parameters that vary slightly from 
those of other related flights in an aggregation. The level is assigned 
by the Analysis Engine utility. 
An atypical flight or phase with parameters that vary moderately 
fiom those of other related flights in an aggregatioa. The level is 
assigned by the Analysis Engine utility. 
An atypical flight or phase with parameters that vary greatly from 
those of other related flights in an aggregation. The level is assigned 
by the Analysis Engine utility. 
A special event that presents a low risk to aviation safety. The level 
is assigned by commercial flight data processing software prior to 
data importation by APMS. 
A special event that presents a medium risk to aviation safety. The 
level is assigned by commercial flight data processing software prior 
to data importation by APMS. 
A special event that presents a high risk to aviation safety. The level 
is assigned by commercial flight data processing s o h a r e  prior to 
data importation by APMS. 
An APMS data importation utility that is used to access the online 
data stores generated by commercial flight data processing software. 
For more information, see the APMS 3.0 System Administrator’s 
Guide. 
A user-defined flight event composed of one or more parameter 
conditions (such as N1-Eng-1-corr I: 45), applied to a specific time 
fiame (such as Ten Minutes before Touchdown). One or more 
modules define a pattern. (This term applies only to the Search 
Pattern tool.) 
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Morning Report Tool 

Parameter 

Parameter Cloud 

Parameter Condition 

Parameter Display Name 

Parameter Editor Utility 

Parameter Trace 

Pattern 

An APMS tool that provides textual descriptions and graphical 
representations of data imported fiom the Analysis Engine’s reports. 
This tool allows analysts to study selected groupings of flights and 
to investigate flight and phase atypicalities. 
A sensor-monitored flight condition, such as average fitel burned per 
hour. Digital flight data recorders are used to register and store a 
numerical value for each parameter every second or fraction of a 
second throughout the flight. Hundreds, or even thousands, of 
parameters can be collected for a single flight. Some parameters 
relate to continuous data (such as altitude and airspeed). Other 
parameters assume just two, or a few, discrete values (such as the on 

fiom an aggregation of flights. The parameter cloud depicts the 
range of digitally recorded values for a single parameter during a 
specific phase. This graphical visualization provides a frame of 
reference against which the parameter trace ‘from a single atypical 
flight can be overlaid and visually assessed by human analysts. 
A user-defmed equation that includes a specific flight parameter, an 
operator, and a numeric value (for example, Airspd-Computed 2 
200). One or more parameter conditions, when applied to a specific 
event fiame, define a module. (This term applies only to the Search 
Pattern tool.) 
The parameter name that appears in the APMS tools used by flight 
analysts. Unlike a generic parameter name that is used only by 
APMS programmers, a display name is usually more meaninghl to 
end-users and can be modified to allow individual airlines to adopt 

An APMS data importation utility. For more information, see the 
APMS 3.0 System Administrator’s Guide. 
In the Morning Report, a graphical representation of data fiom a 
single flight depicting the digitally recorded values for a single 
parameter during a specific phase. The trace appears as a black line. 
A user-defined data map that is used to locate flights that share 
specific characteristics. Each pattern consists of one or more 
modules, or user-defined flight events. (This term applies only to the 
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Performance Report 

Phase 

Phase Atypicality 

Phase Editor Utility 

Reports Tools 

RIN 

Risk Index 

One of two Reports tools. The Performance Report tool generates 
reports from parameter data in the Full Flight Data (FFD) or 
Scrubbed Full Flight Data (SFFD) file. Graph outputs include bar 
charts, line charts, area charts, and histograms. Analysts use this tool 
to determine the overall pattern of performance for an entire group 

Approach) that is defined by the routine event markers that precede 

An anomaly in the digital flight data associated with a specific phase 
of a flight. A flight with phase atypicality contains parameters that 
vary to a significant degree from those of other related flights. The 
Analysis Engine utility identifies flights with phase atypicality and 
ranks the degree of variance. A single flight can have a different 
phase atypicality ranking for each atypical phase. Analysts use the 
Morning Report tool to display flights with phase atypicality. 
Analysts use the Flight Validation tool to confirm or reject the 
anomaly. 
An APMS data importation utility. For more information, see the 
APMS 3.0 System Administrator’s Guide. 
A pair of APMS tools that allow analysts to create custom graphs 
and statistics tables from flight data. The Reports tools consist of the 
Performance Report tool and the Special Event Report tool. The 
Performance Tool generates reports from parameter data in the Full 
Flight Data (FFD) or Scrubbed Full Flight Data (SFFD) file. The 
Special Event Report tool generates reports from a flat file of special 
events, or undesirable flight occurrences. See Performance Report 
Tool and Special Event Report Tool. 
An APMS-computed number that is displayed for every flight that 
matches a pattern. The RIN is the sum of the module risk indices 
that occurred during a flight. The larger the RIN, the greater the risk. 
The RIN allows analysts to locate the most critical flights that 
appear in search pattern results. (This term applies only to the 
Search Pattern tool.) 
An analyst-assigned risk level for each module in a pattern. This 
numerical value allows analysts to weight the relative degree of risk 
from the combined parameter conditions included in the module. 
The larger the number, the greater the risk. The risk index is used to 
compute the RIN for every flight that matches a pattern. Currently, 
there is no default risk index value range in APMS. 
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Routine Event 

Search Pattern Tool 

SFFD 

Special Event 

Special Event Report 

Validated Atypicality 

Validated Special Event 

I 

esc 
A regular flight occurrence (such as Liftoff) that can be identified by 
its unique data signature. A routine event occurs when an individual 
flight parameter (such as air speed, pitch angle, or average fuel 
burned per hour) or combinations of individual flight parameters 
reach a predetermined value or range of values. The APMS Loader 
utility uses pattern search definitions to find and mark routine events 
in the FFD file while importing raw flight data. 

in flight data. The Search Pattern tool allows a flight analyst to 
define flight patterns and use them to query matching flights in the 
APMS database. 
Scrubbed Full Flight Data file. An SFFD is a filtered version of the 

A predefined and undesirable flight occurrence (such as Low Power 
on Approach) that results from operational anomalies. A special 
event, also known as an exceedance, occurs when an individual 
flight parameter (such as air speed, pitch ankle, or average fuel 
burned per hour) or combination of parameters exceeds a 
predetermined, fleet-specific value or range of values. Commercial 
flight data processing software is used to identifl and record special 
events prior to data importation by APMS. 
One of two Reports tools. The Special Event Report tool generates 
reports from a flat file of special events, or undesirable flight 
occurrences. Analysts use this tool to evaluate the numbers and rates 
of special events and to make comparisons with other flights. See 
ReDorts Tool. 

~~ 

A phase atypicality that has been confirmed and flagged as valid by 
a flight analyst. This designation usually indicates that the 
atypicality is legitimate and did not result from bad data. 
A special event that has been confirmed and flagged as valid by a 
flight analyst. This designation usually indicates that the special 
event is legitimate and did not result from bad data. 

Glossary Page 104 of 104 

Revision: 0.5.1 



Form Approved 
OMB No. 0704-0188 

Report Documentation Page 

1. AGENCY USE ONLY (Leave blank) 

biic repomng burden for this collecbon of intonnation is estimated to average 1 hour per reqonse, including the time tor reviewing instructions, searching existing data sources, gathering and maintanmng the data 
eded. and completing and reviewing the collection of information Send comments regarding this burden estimate or any other aspect of this collection of information, including suggestions for reduclng this burden. to 
sshington Headquarters Services, Direclorata for Intormahon Operations and Reports. 1215 JeHerson Davis Highway. Suite 1204, Arlington, VA 222024302, and to the oflice of Management and Budget, Papetwork 
duchon Project (0704.0188), Washington. DC 20503. 

2. REPORT DATE 3. REPORT TYPE AND DATES COVERED 

October 2004 Contractor Report 
4. TITLE AND SUBTITLE 

NAS2-9909 1 
5. FUNDING NUMBERS 

8. PERFORMING ORGANIATION 
REPORT NUMBER 

IH-059 

9. SPONSORlNGlMONlTORlNG AGENCY NAME(S) AND ADDRESS(ES) 

National Aeronautics and Space Administration 
10. SPONSORlNGlMONlTORlNG 

AGENCY REPORT NUMBER 

NASNCR - 2004-2 1 2 8 4  

12A. DISTRIBUTIONIAVAILABILITY STATEMENT 
Subject Category: 03-06 Distribution: Public 
Availability: NASA CAS1 (301) 621-0390 
13. ABSTRACT (Maximum 200 words) 

software-that uses mathematical algorithms and related procedures to analyze digital flight data 
extracted fiom aircraft flight data recorders. 

The Aviation Performance Measuring System (APMS) is a method-embodied in 

128. DISTRIBUTION CODE 

APMS consists of an integrated set of tools used to perform two primary functions: 

0 Flight Data Importation 
0 Flight Data Analysis. 

ta analysis, Flight operations quality assurance, Applied multivariate 

Prescribed by ANSI Std. 2-39-18 
298-102 


